Oracle 11i eJournals

Training Manual
Document Identification

<table>
<thead>
<tr>
<th>Revision</th>
<th>Version 1.1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Compiled By:</td>
<td>Tracy Hudson</td>
</tr>
<tr>
<td>Signature:</td>
<td>Original signed</td>
</tr>
<tr>
<td>Issue Date:</td>
<td>11 January 2006</td>
</tr>
</tbody>
</table>

Authorities

<table>
<thead>
<tr>
<th>Name</th>
<th>Signature</th>
<th>Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Manager</td>
<td>Sue Hickton</td>
<td>Original signed</td>
</tr>
<tr>
<td></td>
<td></td>
<td>16 December 2005</td>
</tr>
</tbody>
</table>

Document History

<table>
<thead>
<tr>
<th>Date</th>
<th>Version</th>
<th>Author</th>
<th>Description of Change</th>
</tr>
</thead>
<tbody>
<tr>
<td>16-12-2005</td>
<td>1.0</td>
<td>Tracy Hudson</td>
<td>Compilation for Training</td>
</tr>
<tr>
<td>11-01-06</td>
<td>1.1</td>
<td>Tracy Hudson</td>
<td>Modification and addition of training content</td>
</tr>
</tbody>
</table>
Oracle 11i - eJournals

Student Guide
# Table of Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Oracle 11i - eJournals .......................................................................</td>
<td>1-1</td>
</tr>
<tr>
<td>Oracle 11i eJournals ........................................................................</td>
<td>1-2</td>
</tr>
<tr>
<td>Objectives</td>
<td>1-3</td>
</tr>
<tr>
<td>Agenda</td>
<td>1-4</td>
</tr>
<tr>
<td>ECU Business Processes</td>
<td>1-5</td>
</tr>
<tr>
<td>Performing Journal Entry Functions</td>
<td>1-8</td>
</tr>
<tr>
<td>Journal Components</td>
<td>1-10</td>
</tr>
<tr>
<td>Agenda</td>
<td>1-12</td>
</tr>
<tr>
<td>Creating Journal Headers</td>
<td>1-13</td>
</tr>
<tr>
<td>Creating Journal Lines</td>
<td>1-15</td>
</tr>
<tr>
<td>Demonstration &amp; Practice</td>
<td>1-17</td>
</tr>
<tr>
<td>Guided Demonstration - Create a General Ledger Journal</td>
<td>1-18</td>
</tr>
<tr>
<td>Practice - Create a General Ledger Journal Batch</td>
<td>1-20</td>
</tr>
<tr>
<td>Solution – Create a General Ledger Journal</td>
<td>1-21</td>
</tr>
<tr>
<td>Agenda</td>
<td>1-23</td>
</tr>
<tr>
<td>Creating Reversing Journals</td>
<td>1-24</td>
</tr>
<tr>
<td>Demonstration &amp; Practice</td>
<td>1-26</td>
</tr>
<tr>
<td>Guided Demonstration - Reverse General Ledger Journal entries</td>
<td>1-27</td>
</tr>
<tr>
<td>Practice - Reverse Journal Entries</td>
<td>1-28</td>
</tr>
<tr>
<td>Solution - Reverse General Ledger Journal Entries</td>
<td>1-29</td>
</tr>
<tr>
<td>Agenda</td>
<td>1-31</td>
</tr>
<tr>
<td>Posting Journals</td>
<td>1-32</td>
</tr>
<tr>
<td>Demonstration &amp; Practice</td>
<td>1-34</td>
</tr>
<tr>
<td>Guided Demonstration - Post General Ledger Journals</td>
<td>1-35</td>
</tr>
<tr>
<td>Practice - Post General Ledger Journals</td>
<td>1-36</td>
</tr>
<tr>
<td>Solution - Post General Ledger Journals</td>
<td>1-37</td>
</tr>
<tr>
<td>Agenda</td>
<td>1-39</td>
</tr>
<tr>
<td>Additional Journal Functionality</td>
<td>1-40</td>
</tr>
<tr>
<td>Summary</td>
<td>1-42</td>
</tr>
</tbody>
</table>
Oracle 11i - eJournals

Chapter 1
Oracle 11i eJournals
Objectives

After completing this lesson you should be able to do the following:

- Understand ECU’s business processes and identify the different journal entry functions and components
- Enter manual journals
- Reverse journals
- Locate and post your approved journals
- Additional journal functionality
Agenda

- Understand ECU’s business processes and identify the different journal entry functions and components
- Enter manual journals
- Reverse journals
- Locate and post your approved journals
- Understand additional journal functionality
ECU Business Processes

Naming Convention:-
ECU has adopted strict naming conventions for journals to ensure unique numbering and assist users in locating journals. It is up to the individual areas, however, to ensure a register of the number is kept. The naming convention that has been approved is:-

Faculty/Centre / School/Branch / Initials of enterer / Number from register

The number register may be kept at individual or business unit level. It is important that the naming convention is adhered to.

Filing of Documents:-
It is up to the individual areas to file their journals, along with any required attachments. Oracle 11i does have the functionality of attaching documentation to on-line journals. If your journal was written on hard copy, this hard copy must be filed. If you enter the journal straight into the General Ledger, a hard copy of the entered journal does not need to be kept.
GPPS recommend that the register is kept for each year and any filing is filed per year and per number order to match the register.

**Approval Hierarchy:-**
In the new General Ledger Journal Entry functionality, an approval hierarchy has been put in place. For the approval hierarchy to be effective, the debiting cost centre must raise the journal, as the journal will follow the approval path of the person entering the journal. During the initial months of the process each Faculty Accountant will be the approver of all journals. This process will be amended over this process.

**Audit Processes**
Audit reports on the journals names will be produced and any areas that do not comply may lose the benefits of entering their own journals.

**Month End**
The first day of each month is the last day that you can enter journals for them to be included in the month end. The cut-off time is 5pm. Please refer to the Shared Services Finance webpage for further details on the month end calendar.

**Journal Categories:-**

**Internal Charge Journals – Category Name = Internal Charge**
To be used for internal transactions only i.e. transactions for the provision of services/goods between one cost centre/project and another cost centre/project. All internal charge journals must have the internal transaction expense account and the corresponding internal transaction account revenue to ensure they net each other off.

Example: Assume the Print and Design Cost Centre charges the Marketing Cost Centre for printing services that the Marketing Cost Centre uses. The journal entry would be as follows:-

<table>
<thead>
<tr>
<th>Debit</th>
<th>Credit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account 9617 (Internal Print and Design Expense)</td>
<td>Account 1917 (Internal Print and Design Income)</td>
</tr>
<tr>
<td>100.00</td>
<td>100.00</td>
</tr>
</tbody>
</table>

**Adjustment Journals – Category Name = Adjustment**
Adjustment journals are used where a journal is being created to correct the posting of a previous transaction. The original transaction should have occurred as follows:-

- An expenditure should have been incurred and entered (and paid) and not merely an encumbrance; or
- An income should have been received and receipted.

If an entire journal is being corrected then the original journal should be reversed and a new miscellaneous journal must be created, making reference to the original journal within the description field.

If a journal adjustment is required, the preferred method is to make the correct in the source system i.e. on the invoice. By using this method, the changes will flow through to the GL during the nightly process.
Miscellaneous Journals – Category Name = Miscellaneous

Miscellaneous journals are to be used for the general day-to-day allocation/distribution of revenue and expenditure and should be used for any item of revenue or expenditure that has not been invoiced. Examples of such journals include the distribution of student fees from a faculty to its various cost centres or projects or the allocation of expenditure amongst various cost centres/projects.

Payroll Journals – Category Name = Payroll

Payroll journals are used for correcting payroll transactions that have been posted to the Salaries Suspense Account because they contain flexfield errors, for example, a disabled or invalid project code. These journals may only be entered by Payroll Personnel.

Accrual Journals – Category Name = Accrual

Accrual Journals may be entered at the end of a month (particularly in December for the end of the financial year) for revenue or expenditure which may have been incurred but which has not yet been processed. Accruals will be automatically reversed in the following month, unless selected to be reversed in an alternative future month. As accrual journals affect the balance sheet, they will only be able to be processed by SSF with the approval of the Financial Accounting Manager.
Performing Journal Entry Functions

Using Oracle General Ledger, Oracle subledgers, and Oracle ADI, you can perform the following journal entry functions:-

• Create journal entries in Oracle General Ledger
• Use ADI to enter large journals from a spreadsheet. A standard ADI template is available from SSF to enable them to process your journal faster. A copy of this template will be forwarded to all attendees of the eJournals training session, alternatively it can be downloaded from the SSF webpage and also the Oracle 11i webpage. Once you have completed the spreadsheet you can forward it to SSF who will import it to the General Ledger. Please ensure that you do not use formulas in your ADI template as this causes errors during the upload process which will delay the processing of your journals. The current process of approvals is required in relation to spreadsheets i.e. you can email the spreadsheet to SSF but must then send through the signed copy of the journal. It is recommended that any recurring journals that are longer than 10 lines are input via ADI journal format.
• Post journal entries
• Inquire on account information and journal entries
• Drill down to subledgers
• Run reports
• Reverse journal entries
Within Oracle General Ledger, you can work with the following types of journal entries:

- **Manual Journal Entries**: The basic journal entry type is used for most accounting transactions. Examples include adjustments and reclassifications.

- **Reversing Journal Entries**: Reversing journal entries are created by reversing an existing journal entry. You can reverse any journal entry and post it to the current or any future open accounting period.
Every journal entry in Oracle General Ledger has two components.

**Journal Components**

Every journal entry belongs to a batch. Oracle General Ledger automatically creates one batch for each journal entry, defaulting the name and the latest open period.

**ECU has a naming convention which must be adhered to for all journals. All entered journals will be checked for audit purposes and any deviation from the policy may result in the eJournal responsibility being revoked from those offenders.**

**Journal Header Information:**
- The header information identifies common details for a single journal entry, such as name, effective date, category, currency and description.

**Group related lines into journal entries:**
- All lines in a journal entry must share the same currency and category.

**Journal Line Information:**
- Journal lines specify the accounting information for the journal entry.
- Total debits must equal total credits for a journal entry for all journal entries.
• Description for each line can be entered optionally. To assist with more detailed reporting and inquiries, it is recommended that line descriptions be added.
Agenda

- Understand ECU’s business processes and identify the different journal entry functions and components
- Enter manual journals
- Reverse journals
- Locate and post your approved journals
- Understand additional journal functionality
Creating Journal Headers

Use this window to enter journals. Once you have entered journal lines, you can examine your journal entries in detail and in T-Account or Summary Activity view. Before posting, you can review and update any journal entries you entered manually.

How to Create a Journal Header:-
1. (N) ECU GL Journals User > Enter GL Journal > (B) New Journal.
2. In the Journals window, enter a Journal name using the ECU naming convention previously discussed.
3. Enter the Period for the journal entry. Note: that you can only post journals in Open periods. If you attempt to use a closed period, the system will not let you continue until you select an open or future-enterable period.
4. Accept or change the default Effective Date for the journal entry.
5. Enter a Category as described in the ECU Business Processes section i.e. Internal Charge, Adjustment or Miscellaneous. All lines in a journal entry share the same journal category.
6. Enter an optional Description for the journal entry. General Ledger uses this as the default description for each journal entry line. You can change the journal entry description as necessary.
7. (Optional) Enter Reference description to further identify the journal entry on general ledger and journal entry reports.
8. Your functional currency appears as the default currency (AUD is the functional currency). To enter a foreign currency journal, specify the currency you want to use and select the corporate exchange rate. The exchange rates have been entered by the Tax/Treasury department. If you require a currency that is not available, contact the Tax/Treasury department for further assistance.

9. (Optional) In the Reverse region, enter a reverse Period. The journal will be automatically reversed when this period is opened. Reversal methods are being covered in more details later in this chapter.

10. You are now able to enter Journal Lines.

Instructor Note:

Remind trainees that yellow fields are mandatory, white fields are additional reference fields and do not need to be completed and grey fields are system fields and are unable to be amended.

You are able to attach documentation to the Journal Header. (I) Paperclip. They can also park the journal they are working on for easy retrieval later. (M) File > Place on Navigator. This was demonstrated during the Navigator and Inquiries Training Courses.
Creating Journal Lines

How to Create Journal Lines:

2. Enter a Line Number for each journal line to control the sequence in which the journal entry lines appear online and in reports. After you enter the first journal entry line number, General Ledger automatically increments the numbers for the following lines. You can change the line numbers as necessary.
3. Enter an account for the journal line. If you know the flexfield this can be typed in using a ‘.’ Between each segment, alternatively you can click on the List of Values (LOV) at the end of the field and you are then able to search for codes/descriptions of your segments.
4. Enter the Debit or Credit amount for the designated account.
5. Tab through the fields on the journal and enter any additional information that is required.
6. Once you have entered all the lines in your journal, (I) Save or Ctrl-S.
7. (B) Approve. If the journal amount it is under your limit, the journal will be automatically approved. If the journal amount is over your approval limit, it will be forwarded to your supervisor for approval. You will be advised via email when the approval has been actioned.
8. (B) Post. Once approved you are able to immediately post the journal to the General Ledger. The information will be available in reports/on-line inquiries. If you do not post
the journal, it will be picked up in the next Autopost process which is regularly run. If you want to make changes to your journal, save it, but do not approve it, otherwise it will be posted.

Other Buttons

(B) Post
Once your journal has been approved you are able to Post it. Once posted, the information will be available for reporting.

(B) Reverse
Once your journal has been approved and posted, you are able to reverse it. This button will be explained later in this chapter.

(B) Approve
This button will approve your journal and make it available for posting. If the journal amount is over your approval, it will be forwarded to your Supervisor for approval. The Approval Status will change to “In Processing”. When your Supervisor approves the journal, the Approval Status will change to “Approved” and the journal can then be posted. Prior to posting you are also able to (B) Unapprove the journal to make amendments and then re-approve the journal.

You will receive Journal Approval notifications via email and they will also be displayed on your Worklist at the top of your Oracle eBusiness Home Page.

(B) Line Drilldown
This button is only enabled on journals that have been imported from a Subsidiary system i.e. Payables, Receivables and Assets.

(B) T Accounts
Use the T Accounts window to view General Ledger journals or subledger accounting entries in a graphical T Account format. This was covered during the Inquiries Training Course you will have attended as a pre-requisite to this training course.
Guided Demonstration & Practice

- Create General Ledger Journals
Guided Demonstration - Create a General Ledger Journal

Responsibility: ECU GL Journals User

(N) > Enter GL Journal

1. (B) New Journal

2. Enter Journal header information:-
   - Journal Name: MSC/RA/TH/001. You must adhere to the naming convention i.e. (Faculty/Centre) / (School/Batch) / (Initials) / (Number)
   - Category: Miscellaneous.
     Note: that you can select different categories i.e. Miscellaneous, Accruals etc.
     Note: Journals with a Category of Accrual will automatically reversed when the next period is opened.
   - Description: Any comments you enter in this field will default in the Description field at your journal lines. This can be overwritten when entering the journal lines.

3. Enter Journal lines information:-
   - Dr: 99999.0541.0100.SA.01.01 $500 (description will default)
   - Cr: 00000.0541.4394.SA.01.01 $500 (description will default)

4. (I) Save or Ctrl-S.

5. (B) Approve. As the journal is under your approval limits it will automatically approve, without having to be submitted to a supervisor. If the journal was over your limit, it would be submitted to your Supervisor. The Approval Status on the journal would say In Process, until the journal was approved. You are not able to post journals that have not been approved.

6. (B) Post.
7. (B) OK.

8. Create another journal.
   − Click on the Journal name and press the down arrow key.

9. Enter Journal header information:
   − Journal Name: MSC/RA/TH/002
   − Category: Miscellaneous.
   − Description: Any comments you enter in this field will default in the Description field at your journal lines.

10. Enter Journal lines information:
    − Dr: 99999.0541.0180.SA.01.01 $500 (description will default)
    − Cr: 03029.0540.1511.SA.01.01 $500 (description will default)

11. (I) Save or Ctrl-S.

12. (B) Approve. As the journal is under your approval limits it will automatically approve, without having to be submitted to a supervisor. If the journal was over your limit, it would be submitted to your Supervisor. The Approval Status on the journal would say In Process, until the journal was approved. You are not able to post journals that have not been approved.

13. (B) OK.
Practice - Create a General Ledger Journal Batch

Overview

In this practice, you will create several journals, approve and post the journals you have created.

Assumptions

- You must have access to the Training database on which to complete this practice.
- Where XX is referenced, you will use the number shown on the training terminal you are using.

Tasks

Log on to the System

- Username = ecutrnXX
- Password = ecutrnXX
- Responsibility = ECU GL Journals User

1. (N) Enter GL Journal.

2. Create the first Journal
   - Journal = Use the naming convention previously described i.e. MSC/RA/TH/001
   - Period = Current period
   - Category = Miscellaneous
   - Description = Novated Lease adjustments

<table>
<thead>
<tr>
<th>Line</th>
<th>Account</th>
<th>Debit</th>
<th>Credit</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td>03100.0541.0215.SA.01.01</td>
<td>500</td>
<td></td>
<td>Novated leasing adjustments</td>
</tr>
<tr>
<td>20</td>
<td>03105.0541.3101.SA.01.01</td>
<td>500</td>
<td></td>
<td>Novated leasing adjustments</td>
</tr>
</tbody>
</table>

3. Save, approve and post your journals.

4. Create a second journal
   - Journal = Using the naming conventions previously described
   - Period = Current period
   - Category = Miscellaneous
   - Description = Catering adjustments

<table>
<thead>
<tr>
<th>Line</th>
<th>Account</th>
<th>Debit</th>
<th>Credit</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td>33555.8335.3201.RE.04.01</td>
<td>1000</td>
<td></td>
<td>Eurest catering charges</td>
</tr>
<tr>
<td>20</td>
<td>78301.1220.4105.SA.06.01</td>
<td>1000</td>
<td></td>
<td>Credit Card</td>
</tr>
</tbody>
</table>

5. Save and approve your journals.
   - Ensure that you do not post this journal.
Solution – Create a General Ledger Journal

Responsibility: ECU GL Journals User

Create First Journal

1. (N) Enter GL Journal > (B) New Journal

2. Create First Journal
   - Journal = As per naming convention
   - Period = Current period
   - Category = Miscellaneous

3. Enter the following:-

<table>
<thead>
<tr>
<th>Line</th>
<th>Account</th>
<th>Debit</th>
<th>Credit</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td>03100.0541.0215.SA.01.01</td>
<td>500</td>
<td></td>
<td>Novated Leasing Adjustments</td>
</tr>
<tr>
<td>20</td>
<td>03105.0541.3101.SA.01.01</td>
<td>500</td>
<td></td>
<td>Novated Leasing Adjustments</td>
</tr>
</tbody>
</table>

4. (I) Save or Ctrl-S.

5. (B) Approve.

6. (B) OK.

7. (B) Post.

8. (B) OK.

Create Second Journal

9. Place cursor in journal header.

10. (M) File > New or use the Down Arrow
    - Journal = as per naming convention
    - Period = Current period
    - Category = Miscellaneous

<table>
<thead>
<tr>
<th>Line</th>
<th>Account</th>
<th>Debit</th>
<th>Credit</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td>33555.8335.3201.RE.04.01</td>
<td>1000</td>
<td></td>
<td>Eurest catering charges</td>
</tr>
<tr>
<td>20</td>
<td>78301.1220.4105.SA.06.01</td>
<td>1000</td>
<td></td>
<td>Credit Card</td>
</tr>
</tbody>
</table>

11. (I) Save or Ctrl-S.

12. (B) Approve.

13. (B) OK.

15. (I) Find and locate the name of your journal that you have just entered.

16. (B) Find.

17. Check the Batch Status = Approved.

18. (M) File > Close Form.
Agenda

- Understand ECU’s business processes and identify the different journal entry functions and components
- Enter manual journals
- **Reverse journals**
- Locate and post your approved journals
- Understand additional journal functionality
Creating Reversing Journals

You create reversing journals for various reasons i.e. miscoding of the original journal, adjustments or monthly accruals.

You have three options for selecting journal entries for reversal:

1. You can select a journal category i.e. accruals which will automatically reverse when the next period is opened.
2. You can create the reversal immediately in the Enter Journals (ECU) Window.
3. When you create a Journal, you can enter the period you wish the reversal to occur in and when that period is opened, the journal will automatically reverse.

Note: If you select the Reversal button in the Enter Journal (ECU) or the Journals (ECU) Windows, the reversing journal will be created immediately.

A journal entry can be reversed only once. However, you can reverse a reversing journal entry.

You can reverse a journal entry in any period after the journal entry is posted. You cannot reverse a journal in a prior period, unless that period is open.
If you reverse a journal, General Ledger creates a reversing journal entry. General Ledger automatically names the reversal journal *Reverses [Original Journal Entry Name] [Date] [Time]*.

You can only reverse a posted journal. If you need to reverse a journal that has been approved but not posted, you must (B) Unapprove the journal and then delete it.

**Reverse journals:**

1. ECU GL Journals User > Enter GL Journal.
2. Query the Journal that you want to reverse.
3. (B) Find.
5. (B) Reverse to generate an unposted journal. General Ledger names the reversal journal *Reverses [Original Journal Entry Name] [Date] [Time]*.
6. You will be asked for a period to reverse the journal. Select the appropriate period. Remember that you cannot post a journal that has been reversed in a future period.
7. Choose OK.
9. (B) Approve.
10. (B) OK.
11. (B) Post the reversing journal.
Demonstration & Practice

- Create reversing Journal entries

Guided Demonstration & Practice
Guided Demonstration - Reverse General Ledger Journal entries

Responsibility: ECU GL Journals User

1. Open the Find Journals window.
   (N) Enter GL Journals

2. Enter the journal name in the Journal field of the Find Journal window.
   − Hint: If you don’t remember the name, use the wildcard (%) and other fields in the
     find screen to reduce your query.

3. (B) Find.

4. (B) Review Journal.

5. (B) Reverse.

6. Select current period.

7. (B) OK.

8. Return to the Enter Journal (ECU) Window and (I) Find to Requery your Journal. The
   Journal name now will begin with Reverse [original batch name] [date] [time].

9. (B) Review Journal. You will note that the status on the journal is now reversed.

10. (B) Approve.

11. (B) OK.
Practice - Reverse Journal Entries

Overview

In this practice you will learn how to:

- Find a Journal
- Reverse the Journal
- Post the Journal

Assumptions

- You must have access to the Training database on which to complete this practice.
- Where XX is referenced, you will use the number shown on the training terminal you are using.

Tasks

Log on to the System

- Username = ecutrnXX
- Password = ecutrnXX
- Responsibility = ECU GL Journals User

Find a Journal

1. (N) Enter GL Journal
2. Locate the first Journal you created earlier.
3. Review the Journal.

Reverse a Journal.

4. Reverse the journal entry in the latest open period.

Approve and Post the Journal.

5. Find the reversal journal that has been created.
6. Approve the Journal.
7. Post the reversal Journal to negate the effect of the original Journal.
Solution - Reverse General Ledger Journal Entries

Responsibility = ECU GL Journals User

Find a Journal

1. Open the Find Journals window.
   (N) Enter GL Journal

2. In the Journal Name of the Find Window, enter the name, or part of the name, of the journal you entered previously.
   − Hint: If you can’t remember the whole name, remember you can use the wildcard % to refine your search.

3. (B) Find.

4. (B) Review Journal.

Reverse a Journal

5. From the Journals window, select (B) Reverse to reverse the journal entry.

6. Select the same period the journal was created in to reverse the journal, and select the OK button to the message that appears.

Posting a Journal

   − Hint: a new journal has been created with a journal name: Reverse "[the name of your journal]" <Date> <Time>.

8. (B) Approve.

9. (B) OK.

10. Post the reversal Journal to negate the effect of the original Journal.

11. (B) Post.

12. (B) OK.
Agenda

- Understand ECU’s business processes and identify the different journal entry functions and components
- Enter manual journals
- Reverse journals
- Locate and post your approved journals
- Understand additional journal functionality
Posting Journals

When you enter your own journals you are able to post them as soon as they have been approved, and the information will be in your reports (excluding Cognos, which is refreshed overnight) as soon as the posting process has completed.

If you are sending ADI journals to Shared Services Finance (SSF) for uploading and use the approved template format, the journals will be posted immediately. If, however, you do not use the SSF ADI template, the journal will be returned to you, so that the correct format is used, which will cause delays.

In addition to manually posting a journal, there is a process running behind the scenes to post journals on a regular basis. Note: When you post a journal, its contents, including descriptive flexfields, cannot be modified. Reversal information within a posted unreversed journal can be modified.

If you send a Journal to SSF there is an approximately five (5) day turnaround for them to be entered and posted. During month end this is dependent on the month end timetable. A copy of the timetable can be located on the SSF webpage.

Posting a journal:-
1. (N) ECU GL Journals User > Enter GL Journal
2. From the Find Journal window, query the journal you want to post. You can also query all unposted journals.
3. (B) Find.
4. (B) Review Journal to review the details of your Journal. The Journal widow appears.
5. Review the Period Status and Post Status to determine if the Journal is available for posting i.e. open period, journal is unposted and has been approved.
6. (B) Post to submit a concurrent request to post the selected journal.

**Posting errors:**

You may receive an error once you have posted your journal. This could be caused by a flexfield value becoming invalid i.e. closed. If this is the case you will need to review your journal, unapprove the journal, make the change and re-approve which will re-start the approval process. If you are having problems, please contact Andrew Dallimore in Financial Accounting.
Demonstration & Practice

- Posting Journals

Guided Demonstration & Practice
Guided Demonstration - Post General Ledger Journals

Responsibility: ECU Finance Officer

Post Journals using the Journal Entry Window

(N) > Data Entry > GL Journals > Enter

1. Locate the Journal you created in your first exercise.
   - Hint: you can select Unposted in the Posting Status to reduce the number of records returned.

2. (B) Find.

3. (B) Review Journal.

4. (B) Post

5. (M) View > Requests

6. (B) Find

7. (B) Refresh Data

8. (B) View Output to ensure that no errors occurred

9. (M) File > Close Form, until you return to the Navigator

Post Journals using the Post Journals Window

(N) > Data Entry > GL Journals > Post

1. (B) Find

2. Select your remaining Journals

3. (B) Post

4. (B) OK

5. (M) View > Requests

6. (B) Find

7. (B) Refresh Data

8. (B) View Output to ensure that no errors occurred

9. (M) File > Close Form, until you return to the Navigator
Practice - Post General Ledger Journals

Overview

There are several methods to Post Journals. You can use Post Journals window, Journal Enter window or Autopost. In this practice, you will use the Journal Enter window and the Post Journals window to post journals.

Assumptions

- You must have access to the Training database on which to complete this practice.
- Where XX is referenced, you will use the number shown on the training terminal you are using.

Tasks

Log on to the System
- Username = ecutrnXX
- Password = ecutrnXX
- Responsibility = ECU Finance Officer

Post a journal using the Journal Entry Window

2. (N) Data Entry > GL Journals > Enter
3. Locate the first Journal you created in your exercises earlier.
4. Post the Journal.
5. Check the output to ensure the journal posted without errors.

Post a journal using the Post Window

7. (N) Data Entry > GL Journals > Post
8. Locate the second Journal you created in your exercises earlier.
10. Check the output to ensure the journal posted without errors.
Solution - Post General Ledger Journals

Responsibility: ECU Finance Officer

Post Journals using the Journal Entry Window

(N) > Data Entry > GL Journals > Enter

1. Locate the Journal you created in your first exercise.
   – Hint: you can select Unposted in the Posting Status to reduce the number of records returned.

2. (B) Find.

3. (B) Review Journal.

4. (B) Post

5. (M) View > Requests

6. (B) Find

7. (B) Refresh Data

8. (B) View Output to ensure that no errors occurred

9. (M) File > Close Form, until you return to the Navigator

Post Journals using the Post Journals Window

(N) > Data Entry > GL Journals > Post

10. (B) Find

11. Select your remaining Journals

12. (B) Post

13. (B) OK

14. (M) View > Requests

15. (B) Find

16. (B) Refresh Data

17. (B) View Output to ensure that no errors occurred

18. (M) File > Close Form, until you return to the Navigator
Agenda

- Understand ECU's business processes and identify the different journal entry functions and components
- Enter manual journals
- Reverse journals
- Locate and post your approved journals
- Understand additional journal functionality
Additional Journal Functionality

In addition to the standard create journals and reverse journals, there are some additional functions that may assist you in interrogating your data more effectively.

Journal Statuses:-
If your journal has been rejected by your approver, you must requery the journal, make the required changes and re-submit the journal for approver. This will send another notification to your approver to re-approve the journal.
If you are an approver, you can enrol in the eApprovers Training Course for more details on all the approval methods for all the Oracle 11i systems. The eApprovers Training Course is not mandatory.

Unapprove a Journal:-
If your journal has been approved and it has not been posted, you are able to select the (B) Unapprove to make changes and re-submit the journal for approval. This can only be done by the originator of the journal.
Deleting Journals:-
You are able to delete a journal if it has not been approved. Once the journal has been approved, you must (B) Unapprove the journal and then delete it. If the journal has been posted you must reverse the journal to negate it’s effect.

Running Reports:-
You are able to run a variety of reports to assist in your analysis of transactions. These reports include:-
- Account Analysis – (180 Char)
- Account Analysis – Payables Detail(180 Char)
- Account Analysis – Subledger Detail(180 Char)
- General Ledger – (180 Char)
- Journals – General (180 Char)
- Trial Balance – Summary 1

For more information reporting, please enrol in the Reporting Training Courses.
Summary

In this lesson, you should have learned how to:

- Understand ECU’s business processes and identify the different journal entry functions and components
- Enter manual journals
- Reverse journals
- Locate and post your approved journals
- Additional journal functionality